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Important Information

SOME TIBCO SOFTWARE EMBEDS OR BUNDLES OTHER TIBCO SOFTWARE. USE OF SUCH EMBEDDED OR
BUNDLED TIBCO SOFTWARE IS SOLELY TO ENABLE THE FUNCTIONALITY (OR PROVIDE LIMITED ADD-
ON FUNCTIONALITY) OF THE LICENSED TIBCO SOFTWARE. THE EMBEDDED OR BUNDLED SOFTWARE
IS NOT LICENSED TO BE USED OR ACCESSED BY ANY OTHER TIBCO SOFTWARE OR FOR ANY OTHER
PURPOSE.

USE OF TIBCO SOFTWARE AND THIS DOCUMENT IS SUBJECT TO THE TERMS AND CONDITIONS OF A
LICENSE AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED SOFTWARE LICENSE AGREEMENT,
OR, IF THERE IS NO SUCH SEPARATE AGREEMENT, THE CLICKWRAP END USER LICENSE AGREEMENT
WHICH IS DISPLAYED DURING DOWNLOAD OR INSTALLATION OF THE SOFTWARE (AND WHICH IS
DUPLICATED IN THE LICENSE FILE) OR IF THERE IS NO SUCH SOFTWARE LICENSE AGREEMENT OR
CLICKWRAP END USER LICENSE AGREEMENT, THE LICENSE(S) LOCATED IN THE “LICENSE” FILE(S) OF
THE SOFTWARE. USE OF THIS DOCUMENT IS SUBJECT TO THOSE TERMS AND CONDITIONS, AND YOUR
USE HEREOF SHALL CONSTITUTE ACCEPTANCE OF AND AN AGREEMENT TO BE BOUND BY THE SAME.

This document contains confidential information that is subject to U.S. and international copyright laws and
treaties. No part of this document may be reproduced in any form without the written authorization of TIBCO

Software Inc.

TIBCO, Better Decisioning, Data Health Check, Data Science, Decisioning Platform, Electronic Statistics Textbook,
Information Bus, Live Score, Making the World Productive, Messaging Appliance, Predictive Claims Flow, Process
Data Explorer, Process Tree Viewer, Rendezvous, Statistica, Statsoft, Statsoft Iberica, The Power of Now, TIB,
TIBCO Rendezvous, and Two-Second Advantage are either registered trademarks or trademarks of TIBCO

Software Inc. in the United States and/or other countries.

Enterprise Java Beans (E]JB), Java Platform Enterprise Edition (Java EE), Java 2 Platform Enterprise Edition (J2EE),
and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle Corporation in the U.S.

and other countries.

All other product and company names and marks mentioned in this document are the property of their respective

owners and are mentioned for identification purposes only.

THIS SOFTWARE MAY BE AVAILABLE ON MULTIPLE OPERATING SYSTEMS. HOWEVER, NOT ALL
OPERATING SYSTEM PLATFORMS FOR A SPECIFIC SOFTWARE VERSION ARE RELEASED AT THE SAME
TIME. SEE THE README FILE FOR THE AVAILABILITY OF THIS SOFTWARE VERSION ON A SPECIFIC
OPERATING SYSTEM PLATFORM.

THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL ERRORS.
CHANGES ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE CHANGES WILL BE
INCORPORATED IN NEW EDITIONS OF THIS DOCUMENT. TIBCO SOFTWARE INC. MAY MAKE
IMPROVEMENTS AND/OR CHANGES IN THE PRODUCT(S) AND/OR THE PROGRAM(S) DESCRIBED IN THIS
DOCUMENT AT ANY TIME.

THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR
INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE, INCLUDING BUT
NOT LIMITED TO ANY RELEASE NOTES AND "READ ME" FILES.

Copyright © 2017 TIBCO Software Inc. All rights reserved. TIBCO Software Inc. Confidential Information
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TIBCO Documentation and Support Services
Documentation for this and other TIBCO products is available on the TIBCO Documentation

site. This site is updated more frequently than any documentation that might be included with
the product. To ensure that you are accessing the latest available help topics, visit:
https://docs.tibco.com

How to Contact TIBCO Support

For comments or problems with this manual or the software it addresses, contact TIBCO

Support:

e For an overview of TIBCO Support, and information about getting started with TIBCO
Support, visit this site:
http://www.tibco.com/services/support

e If you already have a valid maintenance or support contract, visit this site:
https://support.tibco.com
Entry to this site requires a user name and password. If you do not have a user name,

you can request one.

How to Join TIBCO Community

TIBCO Community is an online destination for TIBCO customers, partners, and resident

experts. It is a place to share and access the collective experience of the TIBCO community.

https://www.tibcommunity.com
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Overview

If you are looking for the system requirements please read the release notes.

Customers who have Statistica 12.0.65.4 or later installed on their computers can upgrade to
13.4. They will not need installation keys and can just run the setup.exe. The installer will ask
if the customer wants to upgrade the installation. The customers must select the checkbox

agreeing to upgrade the older Statistica installation.

Customers with older version of Statistica should contact https://support.tibco.com to request
Statistica 13.4keys. Then uninstall Statistica and install Statistica 13.4.

If you purchased TIBCO Statistica™ Pharma or TIBCO Statistica™ Comprehensive use the

installation instructions for:

o0 TIBCO Statistica™ Server
o0 TIBCO Statistica™ Data Entry Server
0 TIBCO Statistica™ Monitoring & Alerting Server

Otherwise, if you have purchased without any add-ons, use the Named User Installation

section.

If you have purchased an add-on, please refer to the section that corresponds with the add-on
that you have purchased. Do not use the Named User Installation section.

Named User Installation

In the past this licensing may have been labeled “per user” or “desktop” or “single user”

installation instructions.

Pre-installation Checklist

1. Users on their client machines must log on with Administrator permissions to complete
the client installation. The installation makes necessary changes to the system. If you are
prompted to reboot during the installation, you must log on with Administrator
permissions after rebooting to complete the installation successfully.

2. If you have 12.0.65.4 or later installed on your computer, uninstall Statistica (see the
Uninstalling section for uninstall instructions). Note that this method of removing
Statistica will not affect or delete any data files created with previous installations. Once

this is complete, proceed with the installation instructions.

Installing
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1. Customer should decide which language they wish to install. Visit
https://edelivery.tibo.com and locate the product.

2. Select the Individual file download option. See image below.

English will be in the TIBCO Statistica Software Component. Customers will need to look at

different versions of Statistica to locate their language. For example, French, Polish,
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Russian, Japanese and German are in the TIBCO Statistica Language Packs for 13.3.1.
nstallation Method

Full Product with Download Manager What's This?
(Uses Akamai MetSession Interface)

* |ndividual file download

+ TIBCO Statistica Software (v 13.3.0)
+ TIBCO Statistica Language Packs (v 13.3.0)

Download the installer and unzip.

Ensure that no other applications are running.

Double-click setup.exe to begin the installation process. If you see a checkbox asking to
upgrade the older Statistica installation, select the checkbox.

Click the Install Statistica button.

The Welcome dialog box will displayed. Click the Next button.

If you selected the checkbox asking to upgrade, you won’t see this dialog. In the Serial
Number/Product Key dialog box, enter the Serial Number and 20- character Product Key
in the respective boxes.

Note: It is important to use the complete keyset as provided by Statistica.

Click the Next button to continue.

If you selected the checkbox asking to upgrade, you won’t see this dialog. And if you
don’t have an install code (part of the keyset), you won’t see this dialog. In the Install
Code dialog box, enter the Install Code. Click the Next button to continue.

In the License Agreement dialog box, read the software license agreement.

Select the I accept the terms in the license agreement option button, and click the Next

button if you agree with the terms and want to continue the installation process.

In the Setup Type dialog box, select either the Typical option button or the Custom option

button.

TIBCO Statistica™ Installation Instructions



10.
11.

12.

13.

14.

15.
16.

17.

18.

19.

19.

Typical setup installs Statistica with the most common options; this is the recommended

selection.

Custom setup options are not covered in these instructions. If you have questions about

the custom installation, contact Statistica for Technical support: https://support.tibco.com.

Click the Next button to continue.

In the Start Menu Folder dialog box, enter the Start Menu Folder Name. The default name
is Statistica 13.

If you want to create a desktop shortcut to Statistica, select the check box. Click the Next
button to continue.

In the Register with Statistica dialog box, enter the requested information in the
appropriate boxes. This information is required to obtain the final licensing file for your
software. Click the Next button to continue.

In the next dialog box, select a method of software registration. Note that all Statistica
products must be registered to obtain the full license. An Internet connection is needed to
automatically register, which is the recommended option.

Click the Next button to continue.

A message may be displayed that prompts you to enable your wireless network adaptor. If
your computer has a wireless network adaptor, enable it until installation is complete in
order to ensure proper licensing of the software. Once it is enabled, click the OK button.
Statistica will now attempt to register your software automatically. A dialog box stating
that your license has been successfully registered is displayed. Click the OK button. If the
registration process fails, a different dialog box will be displayed, indicating the failure.
See the failed registration section below for additional details of failed registration.
Statistica is ready to install. To begin copying files to your machine, click the Install
button.

You should receive a message stating that the installation is complete. You may be
prompted to reboot now or reboot later, depending on the components that were installed

on your machine. If you are prompted, you will need to reboot before you run Statistica.

Click the Finish button to complete the installation process.

Uninstalling
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To uninstall Statistica, follow these steps:

Ensure that no other applications are running,.

In the Control Panel, select Uninstall a program located under Programs.
Scroll down through the list of programs and select Statistica. Click Uninstall to
uninstall the program.

A message will be displayed to confirm that you want to uninstall Statistica from your

TIBCO Statistica™ Installation Instructions


https://support.tibco.com/

computer. Click the Yes button, and Statistica files will be uninstalled.
5. When the uninstall process is complete, click the Yes button to notify the registration

server. This enables you to install Statistica on another computer.

Failed Registration
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The software registration process can fail for several reasons including: exceeding the allowed
number of installations for a serial number, lack of internet connection on the installed

machine, incorrect serial number, or other technical difficulties.

1. If you want Statistica installed on an additional computer, contact Statistica for
information on our policy and additional pricing.

2. If some other issue has affected your registration, ensure that the computer is connected
to the Internet, and verify your serial number. Start Statistica.

o If the Statistica Licensing dialog box is displayed, click the Register button. If the
Statistica Licensing dialog box is not displayed, select the File tab. In the left panel,
click Help/Support. In the right panel, under the Support heading, click Register.

¢ [f the registration process still cannot be completed, contact Statistica for technical
support at https://support.tibco.com/.
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TIBCO Statistica™ Server

If you want to enable versioning and approval for governance of analytics, you need to
download two installers; TIBCO Statistica Software and TIBCO Statistica Documentation
Management System (SDMS) Software.

If you don’t need governance and control over the analytic projects then you just need to

download Statistica installer.

You can download the Statistica installer from the following products on
https://edelivery.tibco.com:

e TIBCO Statistica Analyst

e TIBCO Statistica Comprehensive

e TIBCO Statistica Data Scientist

e TIBCO Statistica Enterprise

e TIBCO Statistica Expert - Data Science

e TIBCO Statistica Expert - Quality Control
e TIBCO Statistica Modeler

e TIBCO Statistica Pharma

You can download the SDMS installer from the following products on

https://edelivery.tibco.com:

e TIBCO Statistica Comprehensive

e TIBCO Statistica Pharma

e TIBCO Statistica Server

e TIBCO Statistica Data Entry Server

e TIBCO Statistica Live Score® Server

e TIBCO Statistica Monitoring & Alerting Server

Note: If the licensing includes Statistica Data Entry Server, then these instructions will also
install this product on the same server with Statistica Server software. You will also see this

product use the name Statistica Web Data Entry Server.

Pre-installation Checklist
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Upgrading SDMS

If you are working on a new installation, you can skip reading this section.

If upgrading SDMS 1.0.2.3 - 1.0.4.0, you will need to complete a few extra steps. This must be
completed before starting installation.

1. Request “access code to add SDMS licensing” on https://support.tibco.com

2. When you receive the access code, follow the emailed instructions on how to apply the
code.

3. Copy ClientSTAT.tmp file from FlexLM server directory (example, C:\Program Files
(x86)\ Statistica\ FLEXIm) to SDMS server directory. The file should be renamed to

TIBCO Statistica™ Installation Instructions
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stat.lic.

The rest of the pre-installation checklist applies to new installations.

Read Admin Guides

It is recommended to read the admin guides posted on https://docs.tibco.com. Search for

Statistica Document Management System and you will locate the SDMS Admin Guide and
Server Admin Guide. Read the Server Admin Guide first.

Database

Statistica Server uses a database to store and manage metadata. An empty database must exist
prior to starting the installer. The Statistica installer will deploy a table schema as part of the
installation process. We recommend using SQL Server or Oracle database. If the limitations

and performance of SQL Server Express is acceptable, this database can also be used.

NOTE: If you decide to use SQL Server Express, you can run the Statistica installer in install

SQL Server Express, create a database with login account and install a table schema.

If you want to use versioning and approval for the metadata objects, run the Statistica
Document Management System installer next. You will be asked for the database name and
login account that was created with the first installer. A second set of tables will be created

within the same database.

One new database will need to be created per environment (production, test, development).
The information below assumes that SQL Server will be used. This database is labeled

[Statistica Enterprise Schema] below, but it is typically named SEWSS.
Complete the following steps.

1.  Create empty database that will be used during installation for [Statistica Enterprise
Schema]. It can be created on existing SQL Server database. This database should
allow for at least 50 MB initial table space.

2. Create a SQL Server user account and make it the owner of [Statistica Enterprise

Schemal]. This user account needs permission to create new tables, views and indices.

Note: After the installation the permissions to create new tables, views and indices
can be removed from this user account. This user account will continue to need

read/write permissions on the database for normal operations.

Server (hardware or VM)

1. Server available for “Statistica Server” software

a. Typically configuration is to have the operating system and Statistica installed on the C
drive. Other programs (example, Microsoft Word) and TEMP space use the D drive.
Contact https://support.tibco.com for help in sizing the D drive.

b. Edit the Windows TEMP and TMP environment variables so that the temp folder is
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located on the secondary (D:) drive.

Optional: Workstation Server for Statistica client

The Statistica workstation software can be installed on employee’s desktop

computers or laptops.

Some customers prefer creating a Citrix or similar terminal services server that users
log into for working with Statistica. This may be preferred because of data security or

regulatory compliance.

Optional: File Server

Some customers have processes that require the use of a file server. Their data is in text or

Excel files. For example, datasets might be published and shared between users on a file share.

This file sharing can also be done via Enterprise Manager Application or a “workstation

server”.

Configuration for Statistica Server

1.
2.

5.

a.

Have login account with administrative access.

Verify database client software is installed for SQL Server. This is the standard
configuration for Microsoft’s operating systems.

Install client software for all DBMS system that data may be extracted from. In other
words, if you need to analyze data from Oracle, Access, SAP ,etc... you will need to
install the ODBC or OLE DB drivers.

Note: These client DBMS packages needed both on the server as well as machines
where the workstation client will be installed. Recommend installing to secondary
(D:) drive.

For 64-bit installations of Statistica the 64-bit versions of the database connectivity
software should be installed.

Microsoft Internet Information Server (IIS) installed on server (IIS Management
Console and IIS Management Service)

Microsoft Internet Information Server (IIS) configured on server

Windows Server 2008, 2012 and 2016: Launch Control Panel > Administrative Tools >
Server Manager and look for the Web Server (IIS) under Roles. Select options below.

i. Internet Information Services > Web Management Tools > IIS 6 Management
Compatibility > IIS Metadatabase and IIS 6 configuration compatibility
ii. Internet Information Services > Web Management Tools >IIS 6 Management
Compeatibility > IIS Management Console
iii. Internet Information Services > Web Management Tools >IIS Management

Service

TIBCO Statistica™ Installation Instructions



iv. Internet Information Services > World Wide Web Services > Application
Development Features > NET Extensibilty (For Newer version of Windows,
.Net Extensibility 3.5 and .Net Extensibility 4.6)
v. Internet Information Services > World Wide Web Services > Application
Development Features > ASP.NET (For Newer version of Windows, ASP.Net
3.5 and ASP.Net 4.6)
vi. Internet Information Services > World Wide Web Services > Application
Development Features > CGI
vii. Internet Information Services > World Wide Web Services > Application
Development Features >ISAPI Extensions
viii. Internet Information Services > World Wide Web Services > Application
Development Features >ISAPI Filters
ix. Internet Information Services > World Wide Web Services > Security >
Request Filtering
x. Internet Information Services > World Wide Web Services > Security >
Windows Authentication
Microsoft Indexing Service installed to the server.
If required to save documents as Word documents or Excel documents, then
installed Microsoft Office 2007 or greater. Installed to secondary (D:) drive.
Optional for pre-installation. This step can also be completed after installation.
Create email account for Statistica application. The application will be sending email

notifications.

Configuration Workstation Server or Workstation Client

1.

If installing workstation on Citrix or VM, there is a server login has administrative
access on for “workstation server”. If logging onto a desktop computer, a login with
administrative rights is needed.

Verify database client software is installed for SQL Server. This is the standard
configuration for Microsoft’s operating systems.

Install client software for all DBMS system that data may be extracted from. In other
words, if you need to analyze data from Oracle, Access, SAP ,etc... you will need to
install the ADO.NET or ODBC drivers.

For 64-bit installations of Statistica the 64-bit versions of the database connectivity

software should be installed.

Server Installation

1.
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Customer should decide which language they wish to install. Visit
https://edelivery.tibo.com and locate the product.

Select the Individual file download option. See image below.

English will be in the TIBCO Statistica Software Component. Customers will need to look
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at different versions of Statistica to locate their language. For example, French, Polish,
Russian, Japanese and German are in the TIBCO Statistica Language Packs for 13.3.1.

nstallation Method

Full Product with Download Manager What's This?
(Uses Akamai MetSession Interface)

* |ndividual file download

+ TIBCO Statistica Software (v 13.3.0)
+ TIBCO Statistica Language Packs (v 13.3.0)

Download the installer and unzip.

Ensure that no other applications are running.

Double-click setup.exe to begin the installation process. If you see a checkbox asking to
upgrade the older Statistica installation, select the checkbox.

Click the Install Statistica button.

The Welcome dialog box will displayed. Click the Next button.

If you selected the checkbox asking to upgrade, you won’t see this dialog. In the Serial
Number/Product Key dialog box, enter the Serial Number and 20- character Product
Key in the respective boxes.

Note: It is important to use the complete keyset as provided by Statistica.

Click the Next button to continue.

If you selected the checkbox asking to upgrade, you won’t see this dialog. And if you
don’t have an install code (part of the keyset), you won’t see this dialog. In the Install
Code dialog box, enter the Install Code. Click the Next button to continue.

In the License Agreement dialog box, read the software license agreement.

Select the I accept the terms in the license agreement option button, and click the Next

button if you agree with the terms and want to continue the installation process.

In the Setup Type dialog box, if you purchased TIBCO Statistica™ Live Score® Server
and/or TIBCO Statistica™ Monitoring & Alerting Server you must select the Custom

TIBCO Statistica™ Installation Instructions



option. Otherwise select Typical.

Typical setup installs Statistica with the most common options; this is the

recommended selection.

Custom setup options can be used to install Statistica on another drive/location or to
change the program features that are typically installed. If you have questions about

the custom installation, contact Statistica technical support: https://support.tibco.com.
Click the Next button to continue.
10. If you selected Typical you won’t see this dialog. In the Custom Setup dialog you

must unselect Live Score and Monitoring and Alerting Service. These products must

be installed on a separate servers.

r al
) Statistica 13 64-bit Setup 5
Custom Setup
Select the program features you want installed.
Click on an icon in the list below to change how a feature is installed.
- Feature D ipti
i =0 v | WebStatistica Repaository - Mea.mrPT Esa;pmonﬁ cervi
i (=3 = | WehStatistica Web Directory R e e

=l ¥ = | Live Score

i ¥ - | Live Score Service

- ¥_~| Live Score Repository
s 3w | Live Score Directory This feature requires OKB on

........ E your hard drive.

--------- =) - | Web Data Entry

--------- =~ | Workstation Installer 84

m

1

Install to:

Change...

Installshield

Space < Back ][ Mext = ] [ Cancel

Click the Next button to continue.

11. In the Enterprise Database Install Type dialog box, choose the type of installation:
either create a new database, or use an existing database. Click the Next button to
continue.

a. Select the Database Management System of your choice.

i. Access

Create New: If you choose to install to a new Access Database, ensure that
bit-width between Statistica and your Microsoft Office match. That is, if you
have 32-bit Microsoft Office, you need to install 32-bit Statistica, or if you

151 Page
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have 64-bit Microsoft office, you need to install 64-bit Statistica. Click the
Next button. In the Access Database Path dialog box, leave the default and
click the Next button. Setup will then create the database, SEWSS.mdb,
using the Statistica Enterprise schema. If a previous SEWSS.mdb exists in

the specified location, setup will create a backup of this database.

Use Existing: If you choose to use an existing Access Database, ensure that
bit-width between Statistica and your Microsoft Office match. That is, if you
have 32-bit Microsoft Office, you need to install 32-bit Statistica, or if you
have 64-bit Microsoft office, you need to install 64-bit Statistica. In the
Access Database Path dialog box, specify the path where this database is
located. Click Browse to select the path to the existing database. The path
will be initially set to the assumed default. Once the appropriate path is
defined, click the Next button.

ii. SQL Server

Create New/Use Existing: If you choose to install to a new SQL Server
Database, in the Data Link Properties dialog box on the Connection tab,
enter or select the server name where the SQL Server Database is located,
and enter the information required to gain access to the server. Ensure that
the database credentials you provide in this dialog box have permissions to
create tables and insert and update tables. Then select the Statistica
Enterprise configuration database on the server. Click Test Connection to
ensure that the connection information is correct. If the test connection is
successful, click OK to apply the connection information. If the test is

unsuccessful, verify that the connection information is correct and try again.

iii. Oracle

Create New/Use Existing: If you choose to install to a new Oracle Database,
in the Data Link Properties dialog box on the Connection tab, enter the
name of the server where the Oracle Database is located and enter the
information required to gain access to the database. Ensure that the
database credentials you provide in this dialog box have permissions to
create tables and insert and update tables. Click the Test Connection button
to ensure that the connection information is correct. If the test connection is
successful, click OK to apply the connection information. If the test is
unsuccessful, verify that the connection information is correct and try again.

Note that Statistica assumes the Oracle client software is installed on the
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12.

13.

14.

15.

16.

17.

18.

19.

20.

server and workstations.
iv. Other

If you choose to install to another database, contact Statistica technical
support https://support.tibco.com .

v. SQL Express Direct Install
Create New: Choosing this option will Install SQL Express 2008 R2 and will

set up the Statistica database automatically.

In the Statistica Server Reports dialog box, click the Next button to continue. This will
create a shared drive to the web directory in which reports will be placed (by default
C:\ WebStatisticaPub\ wwwroot\ WebStatistica Enterprise\ WSReports). It will also
configure your Statistica Enterprise database for Web report creation.

In the Start Menu Folder dialog box, enter the Start Menu folder name; the default
name is Statistica 13. If you want to create a desktop shortcut to Statistica, select the
check box. Click the Next button to continue.

In the Register with Statistica dialog box, enter the requested information in the
appropriate boxes. This information is required to obtain the final licensing file for
your software. Click the Next button to continue.

In the next dialog box, select a method of software registration. Note that all Statistica
products must be registered to obtain the full license. An Internet connection is needed
to automatically register, which is the recommended option. Click the Next button to
continue.

Statistica will now attempt to register your software automatically. A dialog box
stating that your license has been successfully registered is displayed. Click the OK
button. If the registration process fails, a different dialog box is displayed indicating
the failure. See the notes below failed registration section for additional details of failed
registration.

Statistica is ready to install. To begin copying files to your machine, click the Install

button. This may take several minutes.

You will briefly see a DOS command window that states that the web service was
started successfully.

You should receive a message stating that the installation is complete. If a reboot is
required, you may be prompted to reboot now or reboot later, depending on the
components that are installed on your machine. If you are prompted, it will be
necessary to reboot before you run Statistica. Click the Finish button to complete the
installation process.

Create a share to the Statistica executable directory. This share needs to be available to
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all users who need to run the workstation installation. Users must have read and

execute permissions to all files and subfolders.

g( ;]v | » Computer = Local Disk () = Program Files = Statiskica =

Organize * o Cpen  Includein library v+ Sharewith = Mew Folder

- Faworites hlame | [
B Desktop Mas :
4 Downloads W
5| Recent Places Open
WebSTATISTIC CIpen in news window
. Libraries Share with
3 Dacurnents Restare previous wersions

21. To start using Statistica, double-click the Statistica shortcut, and type in the default

login name admin and password abcdef. The Statistica program will launch.

Note: You must change this default administrator password using Statistica Enterprise
Manager application or disable this account after creating a new administrator
account.

22. Ensure that no other applications are running.

23. Download Statistica Documentation Management System (SDMS) installer. Unzip
installer.

24. Double-click Setup.exe to begin the server installation process.

25. The Welcome dialog displays. If you are upgrading SDMS 1.0.6.0 or newer, select Yes

you want upgrade.
Click the Next button.

26. If you are upgrading SDMS 1.0.6.0 or newer, the Resuming the InstallShield Wizard
for SDMS dialog box displays. click the Next button. Once the installation is complete,
click the Finish button to complete. The installation process may require a reboot of the

operating system before you can use SDMS.

27. If you are not upgrading (i.e. a new installation), the In the Setup Type dialog box
displays. Select the installation type: Install both SDMS Server and Client.

The SDMS client application is installed on the server to help with troubleshooting.

This application should never be installed on a workstation.
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29.

30.

31.

32.

33.

34.

35.
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The SDMS Product Key dialog box displays and you enter the Serial Number and

Product Key in the respective boxes.

Note: It is important to use the complete keyset as provided by Statistica.

In the License Agreement dialog box, read the software license agreement.

Select the I accept the terms in the license agreement option button, and click the Next

button if you agree with the terms and want to continue the installation process.

The Setup Type dialog box select the Typical option button to install standard
program features.
In the Locate the Client Licensing file dialog:

a. Click the Browse button and navigate to the directory containing the
ClientSTAT.tmp file. This file is located on your Statistica licensing server
(typically “C:\Program Files (x86)\ Dell\FLEXIm”). This requires the FLEXIm
folder on your licensing server be shared.

b. If you do not wish to share the FLEXIm folder, you may copy the
ClientSTAT.tmp file to another location and browse to it.

c. Click the OK button.

d. Click the Next button.

In the SDMS Database Install Type dialog box, select create a new SDMS database
(new installation of database tables) or use an existing SDMS database (upgrading an
existing installation). In step 10 above you created the connectivity to this database.
In the Database Management System Selection dialog box, select the database
management system that was used in step 10.

In the Ready to Install the Program dialog box, click the Install button to install files
and process other system updates as required. A progress bar displays advising on the
status of the installation process.

Once the installation is complete, click the Finish button to complete. The installation
process may require a reboot of the operating system (i.e., for installing XML Parser)
before you can use SDMS.

NOTE: A default account will be set up within SDMS with user name admin and

password abcdef. This password must be changed. To use this admin account, click

the No button when you see Would you like to use integrated Windows login.
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Workstation Installation
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If a user will be accessing Statistica Server only through a browser, no workstation installation

is necessary. If you want to install Statistica on the Workstation, follow these instructions.

Ensure that no other applications are running.

2. Locate the share that you created (step 19 above) when the Statistica program files were

installed on the server. Double-click the Setup.exe file in Workstation Installer 32 or

Workstation Installer 64 subfolder depending on the bit-width of the workstation.

« Statistica 13 * Workstation Installer 64 »

Mame
I5SetupPrerequisites

| 0x0409.ini
Datal.cab

Tt ent.dsn

E setup.exe

The Welcome dialog box is displayed. Click the Next button.

In the License Agreement dialog box, read the software license agreement. Select the I
accept the terms in the license agreement option button, and click the Next button if you

agree with the terms and want to continue the installation process.

In the Setup Type dialog box, select either the Typical option button or the Custom option
button. Typical setup installs Statistica with the most common options; this is the
recommended selection. Custom setup options are not covered in these instructions. If you
have questions about the custom installation, contact Statistica technical support:

https://support.tibco.com .

Click the Next button to continue.

In the Start Menu Folder dialog box, enter the Start Menu folder name; the default name

is Statistica 13. If you want to create a desktop shortcut to Statistica, select the check box.

Click the Next button to continue.
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7. Statistica is ready to install on your workstation. To begin copying files to your machine,
click the Install button.

8. Your system will be updated and program files will be installed. In the Setup Wizard

Completed dialog box, click the Finish button.

If the workstation’s system files need to be updated, you must restart your computer to finish

the installation process.

9. To start using Statistica, double-click the Statistica shortcut, and type in the default login

name admin and password abcdef.
Note that after installation you should change this default administrator password.

10. If you receive any Version Conflict messages, it is recommended that you keep your

existing file (click the Yes button). These are user preferences.

Server Uninstall

To uninstall the Statistica Server, follow these steps:

Ensure that no other applications are running,.

2. Inthe Control Panel, Programs and Features, scroll down through the list of programs
and select Statistica and SDMS. Right-click and select Uninstall to uninstall the program.

3. A message will be displayed to confirm that you want to uninstall Statistica from your
computer. Click the Yes button, and Statistica files will be uninstalled.

4. When the uninstall process is complete, click the Yes button to notify the registration

server. This makes it possible for you to install the server on another computer.

Workstation Uninstall

To uninstall a Statistica workstation, follow these steps:

Ensure that no other applications are running.
In the Control Panel, select Uninstall a program located under Programs.
Scroll down through the list of programs and select Statistica. Click Uninstall to uninstall

the program.
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User Accounts

Statistica Server validates users based on groups defined on the Statistica Server computer.
These groups are:

e SWS_USER

e SWS_DOWNLOADFILES

e SWS_UPLOADDATA

e SWS_UPLOADSCRIPTS

e SWS_BATCHABLE

e SWS_PORTAL

e SWS_PORTALINTERACTIVE
e SWS_ADMIN

The minimum requirement for authentication on the web server is to be a member of the
SWS_USER group.

Your installation procedure for Statistica Server will attempt to automatically create these
groups for you. If this was not successful, you can create these groups on the Statistica Server
using the Administrative Tools. You can achieve this by opening the Computer Management
dialog box from the Control Panel - Administrative Tools menu. Navigate the tree to find

Local Users and Groups listed. In the Groups folder, create the groups listed above.

Next, add Users to these Groups. Add all Statistica Server users to the SWS_USER group
(Statistica Server administrators as well as Statistica Server users); then add the administrators
to the SWS_ADMIN group, and so on. For customers using active directory, a best practice is
to define global domain groups that correspond to the Statistica Server groups. Then add the
global domain group to the corresponding local groups on the Statistica Server. For example,
you can define a global domain group called GLOBAL_SWS_USER, and add this global
domain group to the local SWS_USER created during Statistica Server install. Now you can
control users to Statistica Server by using Active Directory tools to add/remove users to/from
the GLOBAL_SWS_USER group.

For more details about post installation configuration, consult the WebStatistica
Administrator’s Guide.

Accessing the Web Server
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You must have the latest version of Java installed before you log on. Start your browser and
type in the web address. If you did not change the destination Web directory during

installation, the address will be http://your-server-name/WebStatistica.

Chrome, Firefox and Internet Explorer browsers are supported.
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Using Additional Cores
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Statistica Server is able to distribute the processing of large jobs across multiple core cores on
the server. By default, an installation is configured to utilize two cores. You can purchase an
additional license feature that allows more cores to be used, and then you must manually
configure your Statistica Server installation to use those extra cores. This means you must

increase the number of processes in the pool used to execute analyses on the server.

Statistica Server starts multiple processes that are standing by to handle tasks. There are two
types of processes: short-term processes that handle Ul activities and long-term processes that

handle analyses.

Select All Programs - Statistica - WebStatistica - Administration. In the Pooling section,
select MaxLL.

[~ Bl
“B) WebSTATISTICA cunﬁaurath_blﬂl‘g

File Action View Help
L AR ENCREY
| StatSoft, Inc, ? AsynchrenousTimeoutLL
4 E WebSTATISTICA ? AsynchronousTimeoutSL
4 [F Main site (TODD-WINT) ? ICCancelTimeout
2 T Settings & JCGCPeriad
Al I Mad L
T Connection T MasL
F Email % MinLL
: MinSL
Leggin
% Poiﬁn J ? PageRefreshTime
gg\ Oth i PingTimeout
‘ & % PoolMaintPeriodLL
T System 6" PoolMaintPeriodsL
- B Instan.ces T Refreshinterval_lobList
> B Remote sites STCFGarbageCollectionInterval
9

Mame: ||'~"|axLL
Type: |irrteger
Responsible Object: |LLP00|
Value: |2
Diescription:

Max number of Statistica Servers in pool

The value for MaxLL, along with the value for MinLL, should be set to two times the number
of cores available on the server. For example, a PC with one dual core processor has two cores.

The number of cores available depends on two things: how many physical cores are on the

server and how many cores the Statistica Server license allows to be used.

The number of licensed cores can be determined by selecting All Programs - Statistica -

Concurrent License Manager.
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In the Display By group box, select the Features option button, and then locate the WSNP

feature, which shows how many cores Statistica Server is licensed to use.

When you determine how many cores are available, multiply that number by 2, and set the
MaxLL and MinLL values to that number.

MaxSL and MinSL can usually be left at the default value of 2. After making these changes,

re-start the WebStatistica service.

Notes on Failed Registration

The software registration process can fail for several reasons including exceeding the allowed
number of installations for a serial number, lack of internet connection on the installed

machine, incorrect serial number, or other technical difficulties.

1. If you want Statistica installed on an additional computer, contact Statistica for
information on our policy and additional pricing.

2. If some other issue has affected your registration, ensure that the computer is connected to
the Internet, and verify your serial number. Start Statistica. If the Statistica Licensing dialog
box is displayed, click the Register button. If the Statistica Licensing dialog box is not
displayed, select the File tab. In the left panel, click Help/Support. In the right panel, under
the Support heading, click Register.

3. If the registration process still cannot be completed, contact Statistica technical support at

https://support.tibco.com/ .
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TIBCO Statistica™ Monitoring & Alerting Server

This product is also known as MAS Server.

Pre-installation Checklist

Configuration for MAS Server

1.  Have login account with administrative access with Windows 2008 R2 or later.
2. Verify database client software is installed for SQL Server. This is the standard
configuration for Microsoft’s operating systems.

Note that step 2 is assuming SQL Server is being used for the metadata store. Oracle
may have also be used for the metadata store in step 10 of the Statistica Server
installation instructions. For Oracle installations, the Oracle client must be installed
with the TNSNAMES configuration set to connect to the Oracle database server, and
if installing to 64-bit Windows,

3. These installation instructions assume that an installation of Statistica Server and
already exist on another server. If Statistica Server has not been installed, then please
do so. The MAS Server depends on the existence of this software.

4. The location of the FlexLLM license file on the Statistica Server must be shared and be

accessible to the machine on which the MAS Server installation will be performed.

Firewall Exceptions

The installation process creates firewall exceptions. The following program and ports are
added to the firewall exception list by the installation process. Research if these ports are

acceptable or other port numbers need to be used during the installation process.

Name: Acresso Software Inc.

Path: <flexIm install directory>\Imgrd.exe

Name: Statistica License Manager daemon

Path: <flexIm install directory>\sta_flxm.exe

Name: Statistica License Manager
Port: 26999
Protocol: TCP

Name: Statistica License Manager
Port: 26998
Protocol: TCP
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Diagram of MAS Server & Statistica Server & License Server
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MAS Server Installation
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Ensure that no other applications are running.

The installer used for Statistica Server installation is also used for the MAS Server
installation. Double-click setup.exe to begin the installation process. The installation
process should begin automatically, and the Statistica installation dialog box will be
displayed. Click the Install Statistica button.

The Welcome dialog box is displayed. Click the Next button.

In the Serial Number / Product Key dialog box, enter the Serial Number and Product Key
in the respective boxes. Click the Next button to continue.

If an Install Code was provided, you will see the Install Code dialog box. Enter the Install
Code. Click the Next button to continue.

In the License Agreement dialog box, read the software license agreement. Select the I
accept the terms in the license agreement option button, and click the Next button if you
agree with the terms and want to continue the installation process.

Select a Custom install type. You may receive a message regarding WebStatistica. Ignore
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this message.

8. Deselect the License Manager, WebStatistica, Workstation Installer, Web Data Entry, and
Multimedia features.

9. When prompted for the location of the ClientStat.tmp file, enter the shared directory
location of the FlexLM license file on the Statistica Server.

10. In the Enterprise Database Install Type dialog box, choose the type of installation: use an
existing database. This is the database that was created during the Statistica Server
installation. Click the Next button to continue.

11. Enter the database credentials, including Allow Saving Password. Click Test Connection
to verify the information.

12. Select Yes when prompted to install the Concurrent Session Manager.

13. In the Start Menu Folder dialog box, enter the Start Menu folder name; the default name is
Statistica 13. If you want to create a desktop shortcut to Statistica, select the check box. Click
the Next button to continue.

14. Click the Install button to begin the installation.

15. Your system will be updated and program files will be installed. Click the Finish

button in the Setup Wizard Completed dialog box.

MAS Server Uninstall
To uninstall the Statistica MAS Server, follow these steps:

1. Ensure that no other applications are running.

2. From the Control Panel, select Programs and Features and scroll down through the list
of programs and select Statistica. Click Uninstall

3. A message will be displayed to confirm that you want to uninstall Statistica from your
computer. Click the Yes button, and Statistica files will be uninstalled.

4. When the uninstall process is complete, click the Yes button to notify the Statistica

registration server. This will allow you to install the server on another computer.

Notes on Failed Registration

The software registration process can fail for several reasons including exceeding the allowed
number of installations for a serial number, lack of internet connection on the installed

machine, incorrect serial number, or other technical difficulties.

4. If you want Statistica installed on an additional computer, contact Statistica for
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information on our policy and additional pricing.

If some other issue has affected your registration, ensure that the computer is connected to
the Internet, and verify your serial number. Start Statistica. If the Statistica Licensing dialog
box is displayed, click the Register button. If the Statistica Licensing dialog box is not
displayed, select the File tab. In the left panel, click Help/Support. In the right panel, under
the Support heading, click Register.

If the registration process still cannot be completed, contact Statistica technical support at

https://support.tibco.com/ .
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TIBCO Statistica™ Live Score® Server

This product is also known as Live Score.

Pre-installation Checklist
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Configuration for Live Score Server

1.

These installation instructions assume that an installation of Statistica Server and
already exist on another server. If Statistica Server has not been installed, then please
do so. Live Score depends on the existence of this software.

Note: Live Score and Statistica Server (WebStatistica) components cannot be installed

on the same server.

The location of the Flex].M license file on the Statistica Server must be shared and be
accessible to the machine on which the Live Score Server installation will be

performed.

The server must be installed to a Windows 7 or Windows Server 2008 R2 operating
system or later. Installations on Windows 7 are for training or sandbox
environments.

Have login account with administrative access for Live Score server

The computer on which you are installing Live Score is going to act as a web server.
You should install the web server software on that computer before beginning the

installation procedure.

A web server may already exist on your server. If not, you may need to install

Microsoft Internet Information Services (IIS).

Windows 7: From Control Panel > Programs > Programs and Features > Turn
Windows features on or off, select the following features under Internet Information
Services. From Web Management Tools, select IIS Management Console. From
Common HTTP Features, select Static Content. From World Wide Web Services >
Application Development Features, select ASP.NET, CGI, ISAPI Extensions. From

Security, select Windows Authentication.

Windows Server 2008 and 2012: From the Server Manager console, select Roles >
Web Server (IIS), and then right-click to select Add Role Services. Select Web Server
(Installed). From Application Development, select ASP.NET, CGI, and ISAPI
Extensions. From Security, select Windows Authentication. From Common HTTP

Features, select Static Content.
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The Statistica installation process creates firewall exceptions. The following program
and ports are added to the firewall exception list.

Name: Acresso Software Inc.

Path: <flexIm install directory>\Imgrd.exe

Name: Statistica License Manager daemon

Path: <flexIm install directory>\sta_flxm.exe

Name: Statistica License Manager
Port: 26999
Protocol: TCP

Name: Statistica License Manager
Port: 26998
Protocol: TCP

Name: WebStatistica Service (also known as Statistica Server)
Port: 8081
Protocol: TCP

Live Score Server Installation
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1. Ensure that no other applications are running.

2. The installer used for Statistica Server installation is also used for the Statistica Live Score

Server installation. This installer can be downloaded from https://support.tibco.com again.

Double-click setup.exe to begin the installation process. The installation process should begin
automatically, and the Statistica installation dialog box will be displayed. Click the Install
Statistica button.

3. The Welcome dialog box is displayed. Click the Next button.

4. In the Serial Number / Product Key dialog box, enter the Serial Number and Product Key
in the respective boxes. Note: It is important to use the complete keyset as provided by
Statistica. Click the Next button to continue.

5. If an Install Code was provided, you will see the Install Code dialog box. Enter the

Install Code. Click the Next button to continue.

6. In the License Agreement dialog box, read the software license agreement. Select the I
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accept the terms in the license agreement option button, and click the Next button if you

agree with the terms and want to continue the installation process.

7. In the Setup Type dialog box, select the Custom option button. Typical setup installs
Statistica with the most common options. However, for Live Score, de-select every option
except the Statistica option and the Live Score option. If WebStatistica was purchased, the
components for it are automatically included to install and Live Score will automatically be

de-selected.

8. Click the drop down arrow next to the WebStatistica component and select This feature

will not be available.

9. Then click the drop down arrow next to Live Score and select This feature, and all
subfeatures, will be installed on local hard drive. If you have questions about the custom

installation, contact Statistica technical support: https://support.tibco.com.

10. Click the Next button to continue.

11. In the Enterprise Database Install Type dialog box, choose the type of installation: use an
existing database. This is the database that was created during the Statistica Server
installation. Click the Next button to continue.

12. Enter the database credentials, including Allow Saving Password. Click Test Connection to

verify the information.

13. Select Yes when prompted to install the Concurrent Session Manager.

14. Statistica is ready to install. To begin copying files to your machine, click the Install button.
This may take several minutes.

15. You will briefly see a DOS command window that states that the web service was

started successfully.

16. You should receive a message stating that the installation is complete. If areboot is
required, you may be prompted to reboot now or reboot later, depending on the
components that are installed on your machine.If you are prompted, it will be
necessary to reboot before you run Statistica. Click the Finish button to complete the

installation process.
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Live Score Server Uninstall

To uninstall Statistica Live Score, follow these steps:

Ensure that no other applications are running,.

2. Open Programs and Features and scroll down through the list of programs and
select

3. Statistica. Right-click and select Uninstall.
A message will be displayed to confirm that you want to uninstall Statistica from
your computer. Click the Yes button, and Statistica files will be uninstalled.

5. When the uninstall process is complete, click the Yes button to notify the registration

server. This makes it possible for you to install the server on another computer.

Using Additional Cores
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Live Score is able to distribute the processing of large jobs across multiple core cores on the
server. By default, an installation is configured to utilize two cores. You can purchase an
additional license feature that allows more cores to be used, and then you must manually
configure your Live Score installation to use those extra cores. This means you must increase

the number of processes in the pool used to execute analyses on the server.

Live Score starts multiple processes that are standing by to handle tasks. There are two types
of processes: short-term processes that handle Ul activities and long-term processes that
handle analyses.

Select All Programs - Statistica - WebStatistica - Administration. In the Pooling section,
select MaxLL.
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Diescription:

Max number of Statistica Servers in pool

The value for MaxLL, along with the value for MinLL, should be set to two times the number

of cores available on the server. For example, a PC with one dual core processor has two cores.

The number of cores available depends on two things: how many physical cores are on the

server and how many cores the Live Score license allows to be used.

The number of licensed cores can be determined by selecting All Programs - Statistica -

Concurrent License Manager.
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In the Display By group box, select the Features option button, and then locate the LENP

teature, which shows how many cores Statistica Server is licensed to use.

When you determine how many cores are available, multiply that number by 2, and set the
MaxLL and MinLL values to that number.

MaxSL and MinSL can usually be left at the default value of 2. After making these changes,
re-start the WebStatistica service.
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